
	

https://xirobepabawu.godoxevez.com/84322481170840778608898950077778145100015?kolevedifusowufezezugixidevipotonibonitigitivigujisetef=zurazutapifudifimodidubirafumositewifobotojuvurugumidolubenizegekewabedaparasoluxisifodekatakupejivibajelakisuxejotagezulikorulutepanojekupozaxemoxosevawejibapujeterikubeligakazexumejizekapinetaroredalepo&utm_term=excel+sheet+not+working+formulas&jiralowebomodipakodarijazixuteposadoxudupemiratufituxezujinero=ruvelimenuximonejiralipekumaxifafetibedowaruzedajimejuwewegubimesovunarepoxibijataxofakonamaginefirebedujodegadepanevuzeboxi






























Reason	#1	–	Cells	Formatted	as	Text	Reason	#2	–	Accidentally	Typed	the	keys	CTRL	+	`	Reason	#3	–	Values	are	Different	&	Result	is	Different	Reason	#4	–	Don’t	Enclose	Numbers	in	Double	Quotes	Reason	#5	–	Check	If	Formulas	are	Enclosed	in	Double	Quotes	Reason	#6	–	Space	Before	the	Excel	Formula	Now	let	us	look	at	the	solutions	for	the
reasons	given	above	for	the	Excel	formula	not	working.Now	take	a	look	at	the	first	possibility	of	the	formula	showing	the	formula	itself,	not	the	result	of	the	formula.	For	example,	look	at	the	below	image	where	the	SUM	function	in	excel	shows	the	formula,	not	the	result.The	first	thing	we	need	to	look	into	is	the	format	of	the	cells;	these	cells	are	D1,
D2,	and	D3.	So,	now	take	a	look	at	the	format	of	these	cells.It	is	formatted	as	text.	When	the	cells	are	formatted	as	text,	Excel	cannot	read	numbers	and	return	the	result	for	your	applied	formula.Change	the	format	of	the	cells	to	“General”	or	“Convert	to	Number.”	We	must	first	select	the	cells.	Then,	on	the	left-hand	side,	we	can	see	one	small	icon.
Click	on	that	icon,	and	choose	the	option	“Convert	to	Number.”	Now,	we	must	see	the	result	of	the	formula.	We	are	still	not	getting	the	result	we	are	looking	for.	Now,	we	need	to	examine	whether	the	formula	cell	is	formatted	as	text	or	not.	Yes,	it	is	formatted	as	text,	so	change	the	cell	format	to	“GENERAL”	or	“NUMBER.”	We	must	see	the	result
now.	Often	in	Excel,	when	working	in	a	hurry,	we	tend	to	type	keys	that	are	not	required,	which	is	an	accidental	incident.	But	if	we	do	not	know	which	key	we	typed,	we	may	get	an	unusual	result.One	such	moment	is	SHOW	FORMULAS	in	excel	shortcut	key	CTRL	+	`.	If	we	have	accidentally	typed	this	key,	we	may	see	the	result	like	the	picture
below.As	we	said,	the	reason	could	be	the	accidental	pressing	of	the	show	formula	shortcut	key.The	solution	is	to	try	typing	the	same	key	again	to	get	back	the	results	of	the	formula	rather	than	the	formula	itself.Sometimes,	we	see	different	numbers	in	Excel,	but	the	formula	shows	different	results.	For	example,	the	below	image	displays	one	such
situation.In	cells	D1,	D2,	and	D3,	we	have	10	as	the	value.	In	cell	D4,	we	have	applied	the	SUM	function	to	get	the	total	value	of	cells	D1,	D2,	and	D3.	But	the	result	says	40	instead	of	30.All	the	Excel	file	calculations	are	set	to	automatic.	But	to	enhance	the	speed	of	the	large	data	files,	the	user	might	have	changed	the	auto	calculation	to	a	manual
one.We	can	fix	this	in	two	ways.	One	is	we	can	turn	on	the	calculation	to	“Automatic.”Either	we	can	do	one	more	thing.	We	can	also	press	the	shortcut	key	F9,	which	is	nothing	but	“Calculate	Now”	under	the	“Formulas”	bar.We	must	pass	the	numerical	values	to	get	the	desired	result	in	situations	inside	the	formula.	For	example,	please	take	a	look	at
the	below	image;	it	shows	cities	and	the	average	temperature	in	the	city.If	the	temperature	is	greater	than	25,	then	the	average	should	be	25,	and	if	the	temperature	is	less	than	25,	then	the	average	should	be	20.	Finally,	we	will	apply	the		IF	condition	in	excel	to	get	the	results.We	have	supplied	the	numerical	results	double-quotes	=IF	(B2>25,”	25″,”
20″).	Unfortunately,	when	the	numbers	are	passed	in	double-quotes,	Excel	treats	them	as	text	values.	Therefore,	we	cannot	do	any	calculations	with	text	numbers.Always	pass	the	numerical	values	without	double	quotes	like	the	below	image.Now,	we	can	do	all	sorts	of	calculations	with	these	numerical	values.We	need	to	ensure	formulas	are	not
wrapped	in	double	quotes.	It	happens	when	we	copy	formulas	from	online	websites	and	paste	them	as	it	is.	If	the	formula	is	mentioned	in	double	quotes	for	understanding,	we	need	to	remove	double	quotes	and	paste	them.	Otherwise,	we	may	get	only	the	formulas,	not	the	result	of	the	formula.We	all	humans	make	mistakes.	Typing	mistake	is	one	of
the	errors	for	the	Excel	formula	not	working.	We	usually	commit	day	in	and	day	out	in	our	workplace.	If	we	type	one	or	more	spaces	before	we	start	our	formula,	it	breaks	the	rule	of	the	formulas	in	Excel.	As	a	result,	we	may	end	up	with	only	the	Excel	formula,	not	the	result	of	the	formula.	Let’s	dive	right	into	the	most	common	cause	of	formulas	not
updating:	Calculation	options	set	to	‘Manual	calculation’	mode	What?	 	Could	it	really	be	that	simple?	In	Excel,	it	is	actually	possible	to	change	the	calculation	setting.	You	can	check	and	set	the	current	calculation	mode	like	this:	1.	Click	the	Formulas	tab.	2.	Click	on	Calculation	Options.	3.	Verify	that	the	calculation	setting	is	Automatic.	4.	Formulas
will	not	recalculate	automatically	if	Excel	is	set	to	Manual	calculation	mode.	In	the	practice	Excel	workbook,	the	formula	in	cell	C2	is	a	simple	addition	formula:	=A2	+	B2	You	can	change	the	values	of	A2	&	B2	as	you	wish…	…but	the	formula	result	will	not	change	while	the	setting	is	still	in	Manual	calc	mode.	5.	To	get	the	correct	result,	set	the
Calculation	Options	to	Automatic	calculation	mode.	Voila!	Now	you	can	go	back	to	working	with	Excel	as	usual!	Alternatively…	You	can	also	change	the	calculation	mode	by	going	into	File	>	More…	>	Options	>	Formulas	tab.	There	are	four	calculation	modes	to	choose	from:	Automatic	–	All	dependent	formulas	in	the	entire	workbook	are	recalculated
as	cell	values	change.	Automatic	Except	for	Data	Tables	–	Same	as	Automatic.	But	Data	Tables	are	only	recalculated	if	a	cell	inside	the	table	has	changed	Manual	–	The	entire	workbook	is	only	recalculated	if	you	press	F9.	Or	if	you	click	Calculate	Now	or	Calculate	Sheet	in	the	Formulas	ribbon	Manual	/	Recalculate	before	saving	–	Same	as	Manual	calc
mode.	But	formulas	are	also	recalculated	every	time	you	save	the	file.	But	why	did	my	Calculation	Mode	change?		Bear	in	mind	that	the	calculation	setting	is	an	application-level	setting.	If	you	change	the	Calculation	Mode,	this	applies	to	the	entire	workbook	and	all	other	open	workbooks.	Also,	Excel	uses	the	last	saved	calculation	mode	of	the	first
workbook	opened.	All	workbooks	opened	in	the	same	session	will	use	the	same	mode.	Try	to	open	the	practice	Excel	file	without	any	other	open	workbooks.	You	will	notice	that	it	opens	in	Manual	calculation	mode.	This	was	the	setting	it	was	last	saved	with.	You	can	learn	more	about	Calculation	Mode	behavior	from	the	official	Microsoft	website.	This
is	especially	true	if	the	macro	or	VBA	developer	used	any	of	the	lines	below:	Application.Calculation	=	xlCalculationAutomatic	Application.Calculation	=	xlCalculationManual	If	you	are	not	working	with	a	macro-enabled	workbook,	then	you	can	definitely	rule	this	out!	Why	use	‘Manual	calculation’	mode?	Well,	if	you	are	working	with	a	large	amount	of
data,	you	may	notice	a	slight	lag	or	delay	in	Excel.		This	is	usually	caused	by	Excel	automatically	recalculating	formulas	with	every	change.	This	can	slow	your	work	down	quite	a	lot.		So,	you	can	change	to	Manual	calculation	mode	as	you	enter	or	change	data	and	switch	back	to	Automatic	later	on.	Manual	calculation	shortcuts	In	Manual	mode,	you
can	refresh	formulas	by	pressing	F9.	You	can	also	click	the	Calculate	Now	or	Calculate	Sheet	buttons	in	the	Formulas	ribbon.	This	can	help	you	save	time	and	avoid	the	stress	of	waiting	for	Excel	to	finish	updating	formulas!	We’ll	use	a	dataset	that	contains	student	Names	and	their	scores	in	Math	and	English.	We	will	go	through	some	of	the	most
common	fixes	when	formulas	fail	to	apply	in	Excel.	Fix	1	–	Check	Cell	Format	If	you	type	the	formula	and	see	results	like	the	picture	shown	below,	you	are	seeing	the	formula	as	text.	You	have	probably	put	the	cell	format	as	Text.	Go	to	the	Number	Format	of	the	Home	ribbon	and	check	if	Text	is	selected.	Solution:	Select	the	cell	that	is	showing	this
error.	W	selected	cell	E5.	Go	to	Number	Format	on	the	Home	ribbon	and	select	General.	Press	Enter.	Drag	the	Fill	Handle	and	you	will	get	your	desired	results	in	all	the	other	cells.	The	formulas	should	start	working.	Fix	2	–	Check	for	a	Space	Before	the	Formula	If	the	formulas	still	display	as	texts	in	the	General	format,	there	could	be	a	space	in	front
of	the	equals	sign.	Select	the	cell	where	this	problem	is	showing	and	check	for	a	space	before	the	formula.	Solution:	Select	the	cell	where	this	problem	is	showing.	We	selected	cell	E5.	Delete	the	space	before	the	formula.	Press	Enter	and	you	will	get	the	correct	result	in	that	cell.	Drag	the	Fill	Handle	to	copy	this	formula	to	all	the	other	cells.
Alternatively,	you	can	manually	go	through	cells	to	correct	them.	Fix	3	–	Check	If	Formulas	Are	Enclosed	in	Double	Quotes	If	you	put	a	formula	in	quotes,	it	will	be	used	as	a	string	value	instead	of	a	formula.	Solution:	Delete	the	double	quotes	from	the	formula.	Press	Enter	to	apply	the	formula.	Drag	the	Fill	Handle	to	copy	the	formula	to	all	the	other
cells	if	needed.	We	have	the	correct	result	for	all	the	cells	and	the	formula	is	working	properly.	Fix	4	–	Check	If	Numbers	Are	Enclosed	in	Double	Quotes	If	a	cell	reference	is	in	quotes,	it	won’t	work	in	most	formulas.	The	formula	will	return	a	#VALUE!	error.	Select	the	cell	and	check	the	Formula	Bar	to	see	if	this	is	the	problem.	Solution:		Select	the
cell	where	the	error	is	showing.	Remove	the	double	quotes	from	the	cell	references.	Press	Enter	and	you	will	get	the	correct	result	for	the	cell.		Drag	the	Fill	Handle	to	copy	the	formula	to	the	rest	of	the	cells.	Read	More:	[Fixed]:	Excel	Formula	Not	Showing	Correct	Result	Fix	5	–	Check	for	Circular	References	If	the	formula	fails	to	return	a	value,	it
could	be	trying	to	reference	the	cell	it’s	in	for	computation	(a	circular	reference).	Here’s	how	you	can	check	the	Circular	References.	Go	to	the	Formulas	tab.	Go	to	Formula	Auditing.	Click	Error	Checking.	Put	your	cursor	over	Circular	References.	That	will	show	you	the	cell	that	is	causing	this	problem.	Here,	the	cell	E10	contains	Circular	References.
Solution:	Fix	the	range	or	cell	references	in	the	formula	that	is	causing	the	Circular	references.	Here,	E10	is	causing	the	problem	so	we	removed	it	from	the	formula.	Press	Enter	and	you	will	see	that	your	formula	is	working.	Fix	6	–	Entering	Numbers	with	Formatting	For	this	example,	we	want	a	currency	($)	sign	in	the	result	but	putting	the	currency
sign	in	the	formula	doesn’t	seem	to	work.	This	is	because	currencies	are	processed	in	a	separate	cell	format.	The	$	sign	is	used	to	lock	the	row	or	column	reference	for	the	cell.	Solution:	Select	the	cell	where	you	want	the	currency	($)	sign.	Delete	the	currency	($)	sign	from	the	formula.	Press	Enter	and	you	will	get	the	result	for	the	cell.	Go	to	Number
Format	on	the	Home	ribbon	and	select	Currency.	You	will	get	the	currency	($)	sign	in	your	desired	cell.	Drag	the	Fill	Handle	to	get	the	Currency	formal	in	other	cells.	You	can	change	the	currency	symbol	by	going	to	Format	Cells.	Fix	7	–	Check	If	the	Automatic	Calculation	Option	Is	Selected	In	this	case,	the	first	cell	with	the	formula	produces	the
correct	result.	But,	when	you	drag	the	Fill	Handle	to	copy	the	formula	to	the	other	cells,	the	formula	is	not	working	as	it’s	supposed	to.	One	of	the	possible	reasons	behind	this	is	that	Manual	Calculation	is	selected.	With	this	option,	Excel	doesn’t	calculate	formula	results	until	you	force	it	to.	Solution:	Go	to	the	Formulas	tab.	Go	to	the	Calculations
Option.	Select	Automatic.	You	will	see	that	your	formula	is	working	and	you	are	getting	the	correct	results.	Read	More:	[Fixed!]	SUM	Formula	Not	Working	in	Excel	Fix	8	–	Check	If	You	Have	Deleted	a	Reference	Row,	Column,	or	Cell	If	you	see	a	#REF!	error	like	the	following	image,	you	may	have	deleted	a	reference	that	the	function	used.	Select	the
cell	that	is	showing	the	error.	We	selected	cell	D5.	Check	the	formula	and	see	if	there	are	any	missing	values.	Solution:	Unfortunately,	you	might	not	be	able	to	undo	cell	deletion,	so	be	careful	when	removing	cells	from	the	dataset.	Readjust	the	formula.	Fix	9	–	Check	All	Opening	and	Closing	Parentheses	In	the	following	image,	we	wanted	to	calculate
the	Total	Percentage,	but	we	are	not	getting	the	correct	results.	Since	we	didn’t	use	the	parenthesis,	the	C5	value	is	being	converted	to	8000%	for	the	calculation.	Solution:	Select	the	cell	where	the	problem	is	showing.	We	selected	cell	E5.	Insert	parentheses	by	following	the	PEMDAS	or	BODMAS	rule	to	fix	the	formula.	Drag	the	Fill	Handle	to	copy
the	formula	to	the	rest	of	the	cells.	You	will	see	that	your	formula	is	working	and	you	are	getting	all	the	correct	results.	Fix	10	–	Check	If	All	Required	Arguments	Are	Entered	Properly	Consider	the	following	dataset	with	the	#N/A	error.	We	used	a	VLOOKUP	function	and	wrote	the	formula	as	shown	below.	Here,	I	took	G5	as	lookup_value,	B5:E8	as
table_array,	and	3	as	col_index_number.	But,	I	left	the	range_lookup	blank.	The	formula	isn’t	working	since	the	default	value	is	TRUE	for	an	approximate	match,	and	this	type	of	searching	doesn’t	work	for	unsorted	string	arrays.	Solution:	Select	the	cell	where	the	error	is	showing.	Here,	I	selected	cell	H5.	Write	the	formula	correctly	with	all	the
arguments.	We	used	the	following	formula.	=VLOOKUP(G5,B5:E8,3,FALSE)	Here,	I	have	selected	G5	as	lookup_value,	B5:E8	as	table_array,	3	as	col_index_number,	and	FALSE	as	range_lookup.	Now,	I	have	entered	all	the	arguments	properly.	Finally,	press	ENTER	and	you	will	see	that	the	formula	is	working	properly	and	giving	you	the	correct
answer.	Read	More:	[Solved]:	Excel	Array	Formula	Not	Showing	Result	Fix	11	–	Check	for	Incorrect	Syntax	of	Function	A	formula	might	not	be	working	because	the	syntax	is	wrong	for	the	use.	To	check	this,	select	the	cell	where	the	error	is	showing.	We	selected	cell	H5.	Here’s	the	formula	in	the	cell.	=VLOOKUP(G5,B5:E8,3,TRUE)	Here,	I	have
selected	G5	as	lookup_value,	B5:E8	as	table_array,	3	as	col_index_number,	and	TRUE	as	range_lookup.	The	problem	with	this	formula	is	I	selected	TRUE	as	range_lookup	while	I	want	an	exact	match	for	the	lookup_value.	TRUE	is	for	approximate	match	and	FALSE	is	for	an	exact	match.	While	this	might	not	matter,	the	problem	is	that	“Jim”	is
considered	to	be	“below”	the	string	“Angela”	if	the	array	is	sorted,	and	the	function	isn’t	finding	a	value.	Solution:	Select	the	cell	where	you	want	the	correct	result.	We	selected	cell	H5.	Write	the	formula	properly	will	all	the	correct	syntax.	We	wrote	the	following	formula.	=VLOOKUP(G5,B5:E8,3,FALSE)	Here,	we	have	selected	G5	as	lookup_value,
B5:E8	as	table_array,	3	as	col_index_number,	and	FALSE	as	range_lookup.	We	have	entered	all	the	syntax	correctly.	Press	Enter	and	you	will	see	that	the	formula	is	working	and	giving	you	the	correct	result.	Fix	12.	Check	Whether	Cell	References	Are	Absolute	or	Relative	In	the	following	example,	some	results	are	working	and	others	are	showing
errors.	This	might	be	due	to	lack	of	absolute	cell	references	in	the	formula.	Select	the	formula	cell	and	look	at	the	formula	bar	to	see	the	formula.	We	have	selected	cell	H5,	which	contained	the	following.	=VLOOKUP(G5,B5:E8,3,FALSE)	Here,	I	have	selected	G5	as	lookup_value,	B5:E8	as	table_array,	3	as	col_index_number,	and	FALSE	as
range_lookup.	There	is	nothing	wrong	with	this	formula	if	you	are	writing	this	for	that	particular	cell.	But,	when	you	drag	the	Fill	Handle	to	copy	the	formula	to	the	other	cells,	the	cells	in	the	formula	will	iterate	accordingly.	For	the	next	cell,	the	table_array	has	moved	one	row	down,	which	has	started	to	effectively	remove	searchable	values.	Solution:
Select	the	first	cell	with	the	formula.	Alter	the	formula	to	include	absolute	cell	references	for	lookup	arrays:	=VLOOKUP(G5,$B$5:$E$8,3,FALSE)	Here,	I	have	selected	G5	as	lookup_value,	B5:E8	as	table_array,	3	as	col_index_number,	and	FALSE	as	range_lookup.	We	used	an	absolute	cell	reference	for	the	table_array	so	that	the	selected	range
remains	fixed	while	using	Autofill.	Drag	the	Fill	Handle	to	copy	the	new	formula	to	all	the	other	cells.	The	new	formula	works	properly.	Fix	13	–	Check	If	a	Full	Path	to	a	Closed	Workbook	Is	Included	Here’s	an	example	of	a	formula	that	references	another	workbook,	where	we’re	getting	the	#REF!	error.	In	cell	E5,	which	contains	the	error,	the	formula
is:	=C5+D5+'[Biology.xlsx]Biology'!C5	We	summed	cells	C5	and	D5,	as	well	as	cell	C5	from	another	workbook	named	Biology.xlsx	and	the	worksheet	named	Biology.	The	problem	with	this	formula	that	the	worksheet	is	closed,	and	Excel	can’t	find	the	value	without	a	full	file	path.	Solution:	Select	the	cell	with	an	error.	Insert	the	full	file	path	before	the
workbook	name	like	the	following.	You	will	need	to	find	your	workbook’s	file	path	manually.	=C5+D5+'E:\This	PC\Documents\[Biology.xlsx]Biology'!C5	Press	Enter	and	you	will	get	the	correct	result.	Drag	the	Fill	Handle	to	copy	the	formula	to	all	the	other	cells	if	needed.	The	formula	is	working	properly.	Fix	14	–	Enclosing	Workbook	or	Worksheet	in
Double	Quotes	If	you	accidentally	or	intentionally	enclose	the	worksheet	name	in	a	double	quote	in	the	formula,	then	the	formula	will	show	an	error	like	the	image	below.	Solution:	Select	OK	to	close	the	error	message.	Select	the	cell	where	the	error	is	showing.	Remove	the	quotes	from	sheet	names.	Drag	the	Fill	Handle	to	copy	the	formula	to	all	the
other	cells.	Fix	15	–	Nesting	More	than	the	Allowed	Number	of	Functions	Solution:	If	you	are	using	Excel	2003	or	lower,	you	can	use	up	to	7	nested	functions.	If	you	are	using	Excel	2007	or	newer,	you	can	nest	up	to	64	nested	functions.	Download	the	Practice	Workbook	Formula	Is	Not	Working.xlsx	Knowledge	Hub	Excel	options	>	Formulas	>
Workbook	Calculation	>	Automatic.	If	you	often	switch	between	these	two	modes,	you	can	create	a	custom	keyboard	shortcut	for	Excel	to	speed	up	your	work.	You	might	have	accidentally	formatted	the	cells	containing	the	formulas	as	text.	Unfortunately,	Excel	skips	the	applied	formula	when	set	to	text	format	and	displays	the	plain	result	instead.	The
best	way	to	check	for	formatting	is	to	click	on	the	cell	and	check	the	Number	group	from	the	Home	tab.	If	it	displays	"Text,"	click	on	that	and	choose	General.	To	recalculate	the	formula,	double-click	the	cell	and	press	Enter	on	your	keyboard.	People	commonly	misuse	the	Show	Formulas	button	by	accidentally	turning	it	on.	With	this	turned	on,	the
applied	formulas	will	not	work.	You	can	find	this	setting	under	the	Formulas	tab.	The	Show	Formulas	button	is	designed	for	auditing	formulas,	displaying	the	formula	instead	of	the	result	when	pressed.	This	might	be	a	good	tool	if	you	want	to	better	understand	Excel	formulas,	but	it	stops	them	from	working.	In	this	case,	turning	it	off	may	help	resolve
the	issue.	Go	to	the	Formulas	tab	>	Formula	Auditing	Group	and	click	the	Show	Formulas	button.	Even	if	you're	using	an	Excel	function	for	beginners,	a	missing	or	an	extra	character	might	be	why	your	Excel	formula	isn't	working.	For	example,	when	you	enter	an	additional	equal	to	('=')	or	apostrophe	(')	in	a	spreadsheet	cell,	calculations	are	not
performed,	causing	problems	for	users.	The	issue	typically	occurs	when	users	try	to	copy	a	formula	from	the	web.	However,	it	is	simple	to	fix	this	problem.	Just	head	over	to	the	cell,	select	it,	and	remove	the	apostrophe	or	space	at	the	beginning	of	the	formula.	The	same	goes	for	the	formula's	parentheses.	When	writing	a	lengthy	formula,	make	sure
you	match	all	parentheses,	so	the	calculations	take	place	in	the	correct	order.	Excel	helps	you	by	showing	parentheses	pairs	in	different	colors,	so	you	can	easily	follow	them.	Excel	will	display	an	error	message	when	there's	a	missing	or	extra	parenthesis.	You	might	have	to	separate	function	arguments	to	get	the	desired	outcome	depending	on	which
Excel	formulas	you're	using.	You	should	generally	separate	arguments	using	commas,	but	this	may	vary	depending	on	your	Regional	Settings.	For	example,	in	North	American	countries,	you	must	enter	commas	to	separate	arguments,	while	in	Europe,	the	right	character	is	set	to	a	semicolon.	If	you've	used	the	wrong	separating	character,	Excel	might
show	the	"We	found	a	problem	with	this	formula"	error.	You	can	try	both	options	and	check	which	one	works	for	you.	If	you're	used	to	using	commas	instead	of	semicolons,	or	vice	versa,	you	can	edit	Excel	settings	to	avoid	repeating	the	same	error.	Open	Excel's	File	menu	and	go	to	More	>	Options.	From	the	left	pane,	select	Language.	In	the	Office
display	language	section,	click	the	Add	a	language	button.	Select	the	wanted	language	to	install	and	click	Install.	Select	it	again	and	click	Set	as	Preferred.	Test	if	Excel	formulas	are	now	working.	To	sync	Office	settings	across	your	devices	when	logging	in	with	your	Microsoft	account,	check	the	Store	my	authoring	languages	in	the	cloud	for	my
account	option.	Excel	allows	users	to	recalculate	formulas	manually	if	they	prefer	not	to	use	automatic	calculation	settings.	You	can	do	this	with	these	methods:	For	recalculating	an	entire	spreadsheet,	press	F9	on	your	keyboard	or	choose	Calculate	Now	under	Formula	Tab.	Alternatively,	you	can	recalculate	an	active	sheet	by	pressing	Shift	+	F9	on
your	keyboard	or	selecting	Calculate	Sheet	from	the	Calculation	group	under	Formula	Tab.	You	could	also	recalculate	all	formulas	across	all	worksheets	by	pressing	the	Ctrl	+	Alt	+	F9	keyboard	combination.	Moreover,	if	you	prefer	recalculating	just	one	formula	from	a	sheet,	select	the	cell	and	press	Enter.	Excel	formulas	might	show	the	wrong
results	if	it	uses	circular	referencing,	which	refers	to	the	same	cell	where	it	does	the	calculations.	Most	of	the	time,	Excel	will	notify	you	about	a	circular	reference,	but	it	might	not	do	it	every	time.	Fortunately,	you	can	manually	check	for	this	type	of	reference	if	you	keep	getting	wrong	results	out	of	Excel	formulas.	Open	the	Formulas	tab,	go	to
Formula	Auditing,	and	select	Error	Checking	>	Circular	References.	Excel	will	show	which	cells	have	added	a	circular	reference	to	the	formula.	Go	to	the	indicated	cells	and	edit	the	formula	so	it	doesn't	include	the	cell	showing	the	results.	For	example,	if	the	C13	cell	shows	the	result	for	=SUM(C1:C13),	change	C13	to	C12	within	the	formula	to	fix	it.
The	truth	is,	there's	not	much	room	for	error	when	writing	an	Excel	formula.	A	missing	parenthesis	or	the	wrong	cell	format	is	enough	to	stop	Excel	formulas	from	working	as	intended.	However,	you	should	know	how	to	fix	the	issue	as	you'll	save	a	lot	of	time	having	Excel	do	the	calculations	for	you.	Share	—	copy	and	redistribute	the	material	in	any
medium	or	format	for	any	purpose,	even	commercially.	Adapt	—	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution	—	You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You
may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	—	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	—	You	may	not	apply	legal	terms	or	technological	measures	that	legally
restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended	use.	For	example,	other
rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	We	have	all	experienced	it,	and	often	at	the	worst	possible	moment.	For	whatever	reason,	Excel’s	formulas	aren’t	calculating	correctly.	The	good	news	is	that	it	is	usually	something	simple.	Once	we	know	the	most	likely	causes,	it	is	easier	to	troubleshoot	the	problem.
So,	in	this	post,	we	look	at	the	most	likely	reasons	for	Excel	formulas	not	calculating.	The	14	reasons	and	fixes	in	this	post,	should	give	you	what	you	need	to	know.	So,	if	you’re	concerned	that	Excel	has	stopped	calculating	or	that	numbers	aren’t	updating,	we	have	the	answer	for	you.	Table	of	Contents	Watch	the	video	Watch	the	video	on	YouTube
Excel	has	two	calculation	options,	Automatic	and	Manual.	Most	users	don’t	even	know	these	two	modes	exist.	Yet,	frustratingly,	in	some	circumstances,	they	can	change	without	us	knowing	it.	Automatic	calculation	is	the	default	mode.	This	is	where	formulas	recalculate	after	any	change	affecting	the	result	of	a	calculation.	Excel	formulas	are	efficient
at	handling	calculations.	In	the	background,	Excel	knows	which	cells	impact	which	formulas.	Therefore,	the	Automatic	calculation	mode	recalculates	the	minimum	number	of	cells.	This	ensures	Excel	is	fast	while	keeping	all	the	values	up-to-date.	This	is	the	behavior	that	we	understand	and	expect.	However,	due	to	the	size	and	complexity	of	some
spreadsheets	or	due	to	3rd	party	add-ins,	calculation	speed	can	become	very	slow.	This	leads	some	users	to	change	Excel’s	option	to	Manual	calculation	mode.	Consequently,	Excel	doesn’t	recalculate	anything.	In	Manual	calculation	mode,	we	can	change	cell	values,	but	nothing	happens.	Therefore,	we	must	explicitly	tell	Excel	when	to	recalculate.
Therefore,	if	Excel	is	in	manual	calculation	mode,	it	would	appear	there	is	an	issue	because	we	see	Excel	formulas	not	calculating.	NOTE:	Unfortunately,	Excel	can	change	between	Manual	and	Automatic	calculation	modes	without	us	knowing	it.	So	check	out	this	post:	Why	does	Excel’s	calculation	mode	keep	changing?	To	determine	which	calculation
mode	is	enabled,	click	Formulas	>	Calculation	Options	(drop-down).	The	tick	inside	the	drop-down	identifies	which	calculation	option	is	applied.	Click	Automatic	to	ensure	the	calculation	happens	automatically.	Calculation	mode	is	an	application-level	setting;	therefore,	it	applies	to	all	open	workbooks.	If	you	want	to	remain	in	Manual	calculation
mode,	here	are	some	useful	shortcuts.	F9:	Calculates	formulas	that	have	changed	since	the	last	calculation,	and	formulas	dependent	on	them,	in	all	open	workbooks.	Shift	+	F9:	Calculates	formulas	that	have	changed	since	the	last	calculation,	and	formulas	dependent	on	them,	in	the	active	worksheet.	Ctrl	+	Alt	+	F9:	Calculates	all	formulas	in	all	open
workbooks,	regardless	of	whether	they	have	changed	since	the	last	time	or	not.	Ctrl	+	Shift	+	Alt	+	F9:	Rechecks	dependent	formulas	and	then	calculates	all	formulas	in	all	open	workbooks,	regardless	of	whether	they	have	changed	since	the	last	time	or	not.	This	is	probably	the	#1	reason	why	we	see	Excel	formulas	not	calculating.	TOP	TIP:	Add	the
Automatic/Manual	calculation	options	to	your	QAT.	This	is	an	easy	way	to	switch	between	modes	and	identify	which	mode	is	active.	When	looking	at	cell	values,	we	decide	what	kind	of	data	it	is.	We	know	instinctively	that	numbers	can	be	aggregated,	but	text	cannot.	Unfortunately,	Excel	isn’t	so	clever.	Within	Home	>	Number,	we	can	select	the	cell
format.	If	a	cell	is	formatted	as	text	instead	of	a	number,	Excel	may	not	calculate	and	may	not	display	the	value	we	expect.	Look	at	the	screenshot	below.	In	Cell	B4,	the	SUM	of	B2:B3	equals	1;	1+1	=	1	is	definitely	wrong.	This	is	because	B3	is	formatted	as	text,	and	the	SUM	function	ignores	text.	So,	while	the	calculation	may	look	like	1+1	=	1	(which
is	wrong),	it	is	actually	1+0	=	1	(which	is	correct).	To	fix	this,	here	are	3	options:	Manual	change	Change	the	cell	format	from	Text	to	another	format	(General	is	a	good	option	to	start	with)	Double-click	on	the	problem	cell	to	go	into	edit	mode	Press	return	to	commit	the	formula	If	the	cell	has	a	green	triangle:	Click	on	the	cell	Select	Convert	to
number	from	the	warning	drop-down	Adding	zero	to	the	number	Select	any	blank	cell.	Copy	the	cell	Select	the	cells	to	be	converted	to	numbers	Click	Home	>	Paste	>	Paste	Special…	In	the	Paste	Special	window,	select	Add,	then	click	OK	#1	specifically	relates	to	numbers	formatted	as	text,	but	#2	and	#3	can	be	used	in	many	scenarios	where
numbers	are	stored	as	text.	The	apostrophe	(	‘	)	is	a	special	character	in	Excel.	Whenever	an	apostrophe	is	entered	at	the	start	of	a	value	or	formula,	this	tells	Excel	that	everything	that	follows	is	text.	This	special	character	ensures	we	can	store	numbers	as	text.	For	example,	if	we	wanted	to	hold	an	employee	number	containing	leading	zeros,	Excel
might	remove	the	zeros	on	data	entry.	Therefore,	we	insert	the	apostrophe	to	ensure	Excel	understands	this	as	text.	However,	sometimes	an	apostrophe	can	appear	when	we	don’t	want	it.	This	often	happens	when	the	data	is	imported	from	an	external	system.	The	screenshot	below	shows	a	calculation	that	doesn’t	work	as	expected.	The	formula	in
Cell	B4	is	SUM(B2:B3),	therefore	1	+	1	=	2,	yet	the	value	in	B4	equals	1.	This	is	because	cell	B3	contains	a	value	with	an	apostrophe	preceding	it.	Either	remove	the	apostrophe	manually	or	use	techniques	#2	and	#3	listed	in	the	section	above	to	fix	the	issue.	There	is	a	similar	impact	on	formulas.	For	example,	in	the	screenshot	below,	the	SUM
function	has	a	leading	apostrophe;	therefore,	it	is	treated	as	text.	As	it’s	a	formula,	you	will	need	to	remove	the	apostrophe	manually.	Then	you’re	good	to	go.	Leading	and	trailing	spaces	are	a	big	problem,	they	often	occur	in	imported	text,	but	we	cannot	see	them	with	our	eyes.	Let’s	look	at	an	example.	In	the	screenshot	above,	the	formula	in	Cell	B13
is:	=SUMIFS($B$2:$B$9,$A$2:$A$9,A13)	We	are	performing	a	basic	SUMIFS	function	to	add	the	values	for	product	Alpha.	Based	on	the	data,	the	value	should	be	50,	but	it	calculates	as	zero.	The	problem	is	that	all	the	values	in	Cells	A2:A9	have	trailing	spaces.	Rather	than	“Alpha”,	used	in	Cell	A13	for	the	SUMIFS	function,	the	value	in	the	data	is
“Alpha			“	(with	trailing	spaces).	Excel	views	these	as	different	values.	As	a	result,	there	is	no	match.	To	fix	this,	there	are	lots	of	options.	Some	suggestions	are:	Manually	removing	the	space	from	the	data	Adding	the	trailing	space	into	our	SUMIFS	criteria	Using	the	TRIM	function	to	remove	extra	spaces	from	the	start/end	of	the	text	If	there	are	no
spaces	in	the	middle	of	the	text,	we	can	use	Find	and	Replace	to	remove	extra	spaces.	Another	text/number	mix-up	issue	occurs	when	numbers	are	included	in	double-quotes.	Look	at	the	screenshot	below.	There	is	a	problem;	100+50+100	definitely	does	not	equal	200.	In	this	scenario,	there	is	a	minimum	sale	volume	of	50;	therefore,	using	an	IF
function,	the	value	in	row	3	has	increased	correctly	from	30	to	50.	Consequently,	the	total	should	be	250.	So,	what’s	happened?	The	problem	is	due	to	the	calculation	in	Cell	C3.	The	formula	is:	=IF(B3	Formula	Auditing	>	Error	Checking	>	Circular	References	which	displays	the	circular	references	in	any	of	our	open	workbooks.	As	shown	in	the
screenshot	above,	Cell	B5	has	a	circular	reference.	Once	we	remove	that,	it	will	calculate	correctly.	In	Excel,	we	usually	view	the	results	of	calculations.	However,	with	one	mouse	click	or	one	shortcut,	we	can	quickly	toggle	to	show	formulas	rather	than	results.	Turning	on	show	formulas	can	easily	be	performed	by	accident	or	saved	in	this	state	by	a
previous	user.	To	display	the	formula	results	again,	click	Formulas	>	Formula	Auditing>	Show	Formulas,	or	use	the	shortcut	key	Ctrl	+	`	(the	key	to	the	left	of	the	1	key	on	a	standard	windows	keyboard).	One	thing	we	learn	in	Excel	quite	early	on	is	the	use	of	the	dollar	($)	symbol	to	lock	cell	references.	For	example:	If	we	enter	=A1	into	a	cell	and
copy	it	down,	it	will	change	to	=A2.	If	we	enter	=A$1	and	copy	the	cell	down,	it	will	remain	as	=A$1.	We	get	used	to	this	referencing	syntax	quickly.	However,	this	makes	it	easy	to	make	mistakes	when	copying	formulas	to	other	cells.	Look	at	the	screenshot	above.	There	is	definitely	an	issue	with	the	calculation	in	Cell	D6.	Double-click	on	the	cell,	and
the	problem	will	quickly	reveal	itself.	Yes…	somebody	forgot	that	$	symbols	had	been	used	in	the	formula	in	Cell	C6,	then	they	copied	the	formula	into	Cells	D6	to	F6.	Unfortunately,	it’s	easily	done;	I’ve	done	it	myself	many	times.	How	can	we	find	these	types	of	errors?	The	only	way	is	to	check	our	work	as	we	go,	and	apply	a	healthy	bit	of	skepticism
to	any	calculation	result.	It’s	better	to	self-review	and	find	an	error	than	to	sit	in	a	meeting	with	your	manager,	and	them	find	it.	To	help	reduce	the	number	of	errors	we	make,	Excel	is	programmed	to	auto-correct	/	auto-change	some	data	as	we	enter	it.	This	is	great	most	of	the	time,	and	who	knows	how	often	it	has	saved	us	from	an	embarrassing
mistake.	However,	auto-correction	can	cause	problems	at	other	times.	For	example,	what	do	we	want	if	we	enter	1/1	into	Excel?	Do	we	want	the	result	of	1?	Or	do	we	want	1st	January?	In	this	case,	Excel	assumes	we	want	1st	January	of	the	current	year.	Dates	are	the	most	common	type	of	automatic	conversion.	Dates	in	Excel	are	actually	numbers,
based	on	the	number	of	days	since	31st	December	1899.	So,	assuming	the	current	year	is	2022,	if	we	enter	1/1,	Excel	thinks	we	want	1st	January	2022	(which	is	the	number	44562).	We	can	see	this	when	we	change	the	date	to	a	number	format.	We	tried	to	enter	a	value	of	1/1	and	ended	up	with	a	value	of	44562.	Hmmm…	that	could	cause	us	an	issue.
We	have	already	seen	above	in	#3	that	leading	zeros	can	be	a	problem.	If	we	try	to	enter	a	number	with	leading	zeros,	such	as	0005321,	Excel	assumes	we	don’t	want	the	leading	zeros	and	converts	the	number	to	5321.	To	retain	leading	zeros,	we	should	either:	Add	an	apostrophe	at	the	start	Convert	the	data	type	to	text	before	entering	value	This	is
one	of	my	pet	peeves.	Hidden	rows	and	columns	cause	so	many	problems	for	Excel	users.	In	my	opinion,	they	should	be	avoided	at	all	costs.	Let’s	look	at	an	example:	Look	at	the	screenshot	above.	The	formula	in	Cell	B5	is:	=SUM(B2:B4)	Is	this	result	correct?	Actually,	Yes.	But	the	hidden	row	make	the	result	look	wrong.	This	is	because	the	hidden
row	contains	an	additional	value,	as	we	can	see	when	we	unhide	row	3.	If	we	want	a	calculation	that	excludes	hidden	cells,	we	should	consider	using	the	AGGREGATE	or	SUBTOTAL	function.	Computers	store	numbers	using	binary	(a	mixture	of	1	and	0’s).	Yet	we	learn	numbers	using	a	decimal	base	10	system.	As	a	result,	Excel	must	convert	between
binary	and	decimal	numbers,	which	can	lead	to	some	unexpected	differences.	We	know	one-third	(1/3)	cannot	be	expressed	as	a	decimal;	it	calculates	as	0.333333…	recurring	into	infinity.	So	we	tend	to	use	an	approximation	with	a	reduced	number	of	digits.	In	binary,	there	are	also	numbers	that	have	a	recurring	number	into	infinity.	One-tenth	(1/10)
can	easily	be	expressed	as	a	decimal:	0.1.	But	in	binary,	it	is	00011001100110011…	recurring	into	infinity.	Excel	calculates	to	15	significant	digits.	Therefore,	it	is	possible	for	minor	rounding	differences	to	occur	due	to	the	conversion	from	binary	to	decimal.	While	this	may	be	insignificant,	if	this	is	used	in	a	logic	statement,	it	can	lead	to	an
alternative	result.	Check	out	this	post	for	more	details:	Excel	can	calculate	the	wrong	results:	WARNING	In	this	post	we	have	given	you	the	most	likely	reasons	we	find	Excel	formulas	not	calculating	as	expected.	I	trust	these	14	techniques	have	helped	to	solve	your	problem.	If	you’ve	found	any	other	simple	issues	which	cause	incorrect	calculations,
please	add	them	in	the	comments	below.	Related	posts:	Discover	how	you	can	automate	your	work	with	our	Excel	courses	and	tools.	The	Excel	Academy	Make	working	late	a	thing	of	the	past.	The	Excel	Academy	is	Excel	training	for	professionals	who	want	to	save	time.	Microsoft	Excel	is	a	spreadsheet	application	that	has	been	used	by	millions	of
people	worldwide	for	more	than	three	decades.	Pivot	tables,	graphing	tools,	calculations,	and	a	macro	programming	language	are	included.	In	contrast	to	other	apps	such	as	Word,	spreadsheet	software	calculates	values	using	mathematical	formulas	and	data	in	cells.	However,	there	are	times	when	the	Excel	formulas	do	not	work	properly.	These
issues	can	arise	due	to	various	reasons,	such	as	incorrect	syntax,	referencing	errors,	or	data	inconsistencies	This	article	will	assist	you	in	fixing	Excel	formula	issues	helping	you	streamline	your	data	analysis	and	improve	productivity.	How	to	Fix	Excel	Formulas	Not	WorkingIf	an	Excel	formula	is	not	working	properly	and	returns	an	error	or	incorrect
result.	To	fix	it,	follow	the	steps	below:	Problem:	Change	the	Calculation	Options	from	Manual	to	AutomaticIf	you	are	unable	to	update	the	value	you	have	input	and	it	returns	the	same	value,	Excel's	calculation	option	may	be	set	to	manual	rather	than	automatic.			Fix:	Change	the	Calculation	Option	from	Manual	to	Automatic	Step	1:	Open	the
spreadsheet	that	is	giving	you	problems.	Go	to	the	Formulas	tab,	then	select	the	Calculation	option		Step	2:	From	the	dropdown	option,	select	Automatic	Problem:	Cell	Set	to	Text	FormatYou	may	have	formatted	the	cells	containing	the	formulas	incorrectly	as	text.	When	Excel	is	set	to	text	format,	it	ignores	the	applied	formula	and	does	not	display	the
result.		Fix:	Change	the	Cell	from	Text	Format	to	either	General	or	NumberTo	resolve	this	issue,	follow	the	procedures	below:	Step	1:	Select	the	cell	where	the	formula	is	not	being	calculated		Step	2:	Navigate	to	Home,	and	you'll	see	a	Dropbox	with	multiple	data	kinds	in	the	center.	Choose	General	or	Number		Step	3:	Now,	click	the	cell	once	more
and	Select	Enter.	The	formula	will	be	automatically	calculated,	and	the	result	will	be	displayed	in	the	cell		Problem:	Show	Formulas	Button	Is	Turned	OnIf	show	formulas	button	is	turned	on	accidently	then	the	applied	formulas	will	not	work.	Fix:	Turn	off	the	Show	Formulas	ButtonThe	Show	Formula	button	is	intended	for	auditing	formulas,	therefore
when	selected,	it	displays	the	formula	rather	than	the	result.	As	a	result,	if	you	previously	turned	it	on,	turning	it	off	may	help	remedy	the	problem.	Here's	how	to	go	about	it:	Step	1:	Navigate	to	the	Formula	Tab	and	click	the	Show	Formulas	button	under	the	Formula	Auditing	Group		Excel	formulas	Not	UpdatingThe	value	provided	by	your	Excel
formula	does	not	automatically	update,	which	means	that	the	formula	displays	the	old	value	even	after	you	modify	the	values	of	the	dependent	cells.	When	Excel	formulas	do	not	update	automatically,	it	is	most	likely	because	the	Calculation	setting	has	been	set	to	Manual	rather	than	Automatic.	To	resolve	this,	simply	return	the	Calculation	option	to
Automatic:	Step	1:	Navigate	to	the	Formulas	tab	on	the	Excel	ribbon,	then	to	the	Calculation	group,	click	the	Calculation	Options	button,	and	then	select	Automatic.		Excel	formulas	Not	CalculatingIf	your	Excel	formula	isn't	working,	the	reason	can	be	that	a	cell	displays	the	function	rather	than	the	calculated	value,	it	could	be	due	to	one	of	the
following	issues.	Problem:	Incorrect	Excel	FormulaWhile	working	with	Excel,	even	if	you	are	new	to	using	Functions,	a	common	issue	that	may	arise	is	the	presence	of	missing	or	extra	characters.	For	Example,	if	you	use	(=)	an	equal	sign	or	apostrophe(')	in	a	cell	can	prevent	calculations	from	being	performed	correctly.	This	problem	may	occur	when
users	haven't	typed	the	formula	and	copied	it	from	other	sources.	Fix:	Check	your	Excel	FormulaYou	can	fix	this	problem	by	following	the	below	tips:	Step	1:	Select	the	cell	with	the	formula	and	remove	any	unnecessary	apostrophes	or	spaces	at	the	beginning	of	the	formula	Step	2:	You	should	take	care	of	parenthesis	while	using	lengthy	formulas.
Ensure	that	all	opening	and	closing	parenthesis	match	correctly	so	that	the	opening	and	closing	parenthesis	match	correctly	so	that	calculations	happen	in	the	right	order.	Excel	can	help	you	with	this	by	displaying	parenthesis	in	different	colors	to	make	it	easier	to	track	them	Excel	will	show	an	error	if	there	is	a	missing	or	extra	parenthesis	in	your
formula.	Keep	in	mind	these	common	formula	problems	to	make	your	Excel	experience	smoother	and	more	productive.	Problem:	Wrong	Characters	UsageYou	have	to	use	separate	function	arguments	to	use	for	the	excel	formulas	to	calculate	and	give	desired	correct	outputs.	Fix:	Use	Proper	Characters	to	Separate	ArgumentsTo	get	the	desired	results
in	Excel,	it's	essential	to	know	how	to	separate	functions	and	arguments	correctly.	Depending	upon	the	Excel	formula	you're	using	and	your	regional	settings,	you	may	need	to	use	commas	or	semicolons	to	separate	arguments.	Using	the	wrong	separator	can	lead	to	a	"We	Found	a	Problem	with	this	Formula"	error	in	Excel.	There's	a	way	to	adjust
Excel	settings	to	avoid	repeating	this	error:	Step	1:	Open	Excel's	File	menu	Step	2:	Go	to	More	and	select	Options	Step	3:	Select	Language	from	the	left	pane	Step	4:	In	the	office	display	language	section,	click	on	the"	Add	a	language"	button	Step	5:	Choose	the	desired	language	to	install	and	click	Install	Step	6:	Select	the	newly	installed	language	and
click	"Set	as	Preferred"	Step	7:	Test	your	Excel	Formulas	to	see	if	they	are	now	working	correctly	To	sync	Office	settings	across	your	device	when	logging	in	with	your	Microsoft	account,	check	the	Store	my	authoring	languages	in	the	Cloud	for	My	Account	option.	If	users	don't	prefer	to	use	automatic	calculation	settings,	Excel	allows	users	to
Recalculate	formulas	manually.	You	can	do	this	by	following	below	methods:	For	Recalculating	the	entire	sheet,	you	can	press	F9	on	your	keyboard	or	choose	to	Calculate	Now	under	the	Formula	tab.	You	can	also	recalculate	an	active	sheet	by	pressing	Shift	+F9	on	your	keyboard	or	by	selecting	the	Calculate	sheet	from	the	Calculation	group	under
Formula	Tab.	You	can	also	recalculate	all	formulas	across	all	worksheets	by	pressing	the	Ctrl+	Alt	+F9.	Check	for	Circular	ReferenceIf	Excel	uses	circular	reference	it	might	sometimes	show	wrong	results.	Most	of	the	time,	Excel	will	notify	you	about	a	circular	reference,	but	it	might	not	do	it	every	time.	Note:	Circular	reference	refers	to	the	same	cell
where	is	does	the	calculations.	You	can	manually	check	for	this	type	of	reference	if	you	continuously	getting	wrong	results	out	of	Excel	formulas.	Follow	the	below	steps:	Step	1:	Open	the	Formulas	Tab	Step	2:	Go	to	Formula	Auditing	Step	3:	Select	Error	Checking	Circular	Reference	Now	Excel	will	show	which	cells	have	added	a	circular	reference	to
the	Formula.	Go	to	the	indicated	cells	and	edit	the	formula	so	it	doesn't	include	the	cell	showing	the	results.	Check	for	any	syntax	errors.Check	missing	or	extra	charactersEnsure	correct	cell	reference.	Use	Excel's	Formulas	auditing	tools	to	trace	precedents	and	dependents,	and	evaluate	complex	Formulas	to	identify	the	issue.	Excel	Formula	error
message	occurs	due	to	the	following	reasons:	Division	by	zeroValue	not	foundIncorrect	data	types.	To	correct	these	errors,	you	can	use	functions	such	as	IFERROR	or	ISERROR	to	display	custom	messages	or	handle	specific	situations.	Follow	the	below	steps	to	troubleshoot	Excel	Formulas:	Step	1:	Check	the	Formula	syntax	Step	2:	Use	formula
auditing	tools	Step	3:	Handle	Error	values	Step	4:	Verify	data	types	Step	5:	Ensure	correct	argument	separators	Step	6:	Review	conditional	formatting	and	data	validation	rules.	To	avoid	common	Excel	formulas:	Double-	Check	formula	syntaxEnsure	correct	cell	referenceMatch	parenthesis	carefullyUse	correct	argument	separatorsBe	careful	about	the
data	types.Use	formula	auditing	toolsYes,	Error	messages	can	be	customized	in	Excel	Formula	using	Functions	like	IFERROR	and	ISERROR.	By	providing	specific	messages	or	alternative	values.	Readers	help	support	Windows	Report.	We	may	get	a	commission	if	you	buy	through	our	links.	Read	our	disclosure	page	to	find	out	how	can	you	help
Windows	Report	sustain	the	editorial	team.	Read	more	Key	notes	If	you	enable	the	auto-calculate	option,	Excel	will	automatically	update	the	formulas	when	the	values	​​change.To	see	the	calculated	output	instead	of	the	formula,	make	sure	the	cell	format	is	set	to	"General".	Excel	is	essentially	one	big	calculator	that	can	also	display	numerical	data	in
the	form	of	spreadsheet	tables	and	graphs.	Formulas	(or	functions)	are	the	cornerstone	of	Excel	that	perform	a	multitude	of	calculations	and	display	them	within	spreadsheet	cells.	Excel’s	formulas	make	it	one	of	the	most	essential	MS	Office	applications.	However,	sometimes	Excel	might	not	always	calculate	formulas	automatically.	When	that
happens,	the	formulas	don’t	automatically	update	when	users	change	the	values	they’re	based	on.	Alternatively,	sometimes	Excel	might	just	display	the	formulas	within	cells	instead	of	their	results.	If	either	of	those	scenarios	sounds	familiar,	check	out	some	of	the	resolutions	for	them	below.	If	Excel	functions	don’t	auto-calculate	when	you	modify	the
values	they’re	based	on,	the	default	automatic	calculation	mode	probably	isn’t	enabled.	Click	the	File	tab	at	the	top	left	of	Excel.Click	Options,	which	opens	the	Excel	Options	window.	Click	the	Formulas	tab	on	the	left	of	the	window.Is	the	Manual	option	there	selected?	If	so,	select	the	Automatic	setting.Click	OK	to	close	the	Excel	Options	window.	If
an	Excel	spreadsheet	displays	all	its	formulas	within	cells,	the	Show	Formulas	option	is	probably	enabled.	To	disable	that	option,	click	the	Formulas	tab	in	Excel.	Then	click	the	Show	Formulas	button	on	that	tab.	You	can	also	press	the	Ctrl	+	`	hotkey	to	toggle	the	Show	Formulas	button	off/on.	Excel	will	also	display	formulas	instead	of	calculated
output	in	cells	when	the	cells	have	a	text	format.	To	check	if	that’s	the	case,	select	a	spreadsheet	cell	that’s	displaying	a	formula.	You	might	see	Text	in	the	format	drop-down	menu	shown	in	the	snapshot	directly	below.	Select	General	on	the	drop-down	menu.	Then	the	cell	will	display	calculated	output	when	you	click	within	the	formula	bar	(with	the
cell	selected)	and	press	the	Return	key.	Excel	won’t	automatically	calculate	formulas	when	they	haven’t	been	entered	correctly.	One	of	the	things	hardest	to	spot	is	a	space	in	the	formula	just	ahead	of	the	equals	(=).	When	there’s	a	space	right	at	the	beginning	of	the	formula,	its	cell	will	display	the	function	instead	of	a	result	for	it.	So,	make	sure	there
aren’t	any	spaces	at	the	start	of	functions.	If	the	formula	contains	spaces	anywhere	else,	Excel	will	display	#Name?	in	its	cell.	So,	that’s	how	you	can	fix	an	Excel	spreadsheet	that	doesn’t	automatically	calculate	its	formulas.	Thereafter,	the	spreadsheet’s	cells	will	automatically	display	the	results	for	formulas	as	expected.	For	any	other	questions	or
suggestions,	feel	free	to	reach	for	the	comments	section	below.	RELATED	ARTICLES	TO	CHECK	OUT:	This	tutorial	explains	the	most	common	mistakes	when	making	formulas	in	Excel,	and	how	to	fix	a	formula	that	is	not	calculating	or	not	updating	automatically.Can	someone	imagine	using	Microsoft	Excel	without	formulas?	I	believe	no	one	can.	And
hardly	anything	could	compare	to	the	frustration	caused	by	Excel	formulas	stop	working	all	of	a	sudden.	When	this	happens,	a	bunch	of	questions	immediately	flash	across	your	mind.	Why	is	my	Excel	formula	not	calculating?	Why	doesn't	this	formula	update	its	value	automatically?	Is	my	Excel	corrupt	or	is	this	due	to	some	malicious	virus?	And	how
do	I	get	my	Excel	to	calculate	and	update	formulas	automatically	again?	Don't	worry,	most	likely	your	Excel	is	all	right,	and	you	will	get	all	the	answers	in	a	moment.	Symptoms:	Excel	formula	not	working	correctly,	it	returns	an	error	or	a	wrong	result.	This	section	provides	a	summary	of	the	most	common	mistakes	people	make	when	creating
formulas	in	Excel	and	solutions	to	fix	them.	As	you	know,	the	arguments	of	Excel	functions	are	entered	within	the	parentheses.	In	complex	formulas,	you	may	need	to	enter	more	than	one	set	of	parentheses,	one	within	another,	to	indicate	the	order	in	which	the	calculations	should	take	place.	When	creating	such	a	formula,	be	sure	to	pair	the
parentheses	properly	so	that	you	always	have	a	right	parenthesis	for	every	left	parenthesis	in	your	formula.	Microsoft	Excel	displays	the	parentheses	pairs	in	different	colors	as	you	enter	them	in	a	formula.	If	your	formula	is	short	of	one	or	more	parentheses,	Excel	displays	an	error	message	and	suggests	a	correction	to	balance	the	pairs.	Please	see
How	to	highlight	and	match	parenthesis	pairs	for	more	information.	All	Excel	functions	have	one	or	more	required	arguments.	Some	functions	also	have	optional	arguments,	which	are	enclosed	in	[square	brackets]	in	the	formula's	syntax.	A	formula	must	contain	all	of	the	required	arguments,	otherwise	Excel	displays	"You've	entered	too	few
arguments	for	this	function"	alert.	If	you	have	entered	more	arguments	than	allowed	by	the	formula's	syntax,	you	will	get	"You've	entered	too	many	arguments	for	this	function"	error	message.	When	nesting	two	or	more	Excel	functions	into	each	other,	e.g.	creating	a	nested	IF	formula,	remember	about	the	following	limitations:	In	Excel	2016,	Excel
2013,	Excel	2010	and	Excel	2007,	you	can	use	up	to	64	nested	functions.	In	Excel	2003	and	lower,	only	up	to	7	nested	functions	can	be	used.	In	Excel	formulas,	any	value	enclosed	in	double	quotes	is	interpreted	as	a	text	string.	What	it	means	is	that	if	you	enter	a	formula	like	=IF(A1>0,	"1"),	Excel	will	treat	number	1	as	text,	and	therefore	you	won't
be	able	to	use	the	returned	1's	in	other	calculations.	To	fix	this,	just	remove	the	double	quotes	around	"1":	=IF(A1>0,	1).	So,	whenever	you	are	writing	a	formula	for	numerical	values,	follow	this	simple	rule:	don't	enclose	numbers	in	double	quotes	unless	you	want	them	to	be	treated	as	text.	When	using	a	number	in	an	Excel	formula,	don't	add	any
decimal	separator	or	currency	sign	like	$	or	€.	Remember	that	in	Excel	formulas,	a	comma	is	typically	used	to	separate	a	function's	arguments,	and	the	dollar	sign	makes	an	absolute	cell	reference.	For	instance,	instead	of	entering	$50,000	in	your	formula,	input	simply	50000,	and	use	the	Format	Cells	dialog	(Ctrl	+	1)	to	format	the	output	to	your
liking.	Numbers	formatted	as	text	values	are	another	common	reason	for	Excel	formulas	not	working.	At	first	sight,	they	look	like	normal	numbers,	but	Microsoft	Excel	perceives	them	as	text	strings	and	leaves	out	of	calculations.	The	visual	indicators	of	text-numbers	are	as	follows:	Numbers	formatted	as	text	are	left-aligned	by	default,	while	normal
numbers	are	right-aligned	in	cells.	The	Number	Format	box	on	the	Home	tab	in	the	Number	group	displays	the	Text	format.	When	several	cells	with	text	numbers	are	selected	on	the	sheet,	the	Status	Bar	only	shows	Count,	while	usually	it	shows	Average,	Count	and	SUM	for	numbers.	There	may	be	a	leading	apostrophe	visible	in	the	formula	bar,	or
green	triangles	appear	in	the	top-left	corner	of	the	cells.	The	below	screenshot	shows	that	even	a	simple	Excel	SUM	formula	may	not	work	because	of	numbers	formatted	as	text:	To	fix	this,	select	all	problematic	cells,	click	the	warning	sign,	and	then	click	Convert	to	Number:	In	some	cases,	however,	neither	green	triangles	nor	the	warning	sign
appear	in	cells.	For	example,	if	you	enclose	numeric	values	in	double	quotes	in	your	formulas,	Excel	assumes	you	want	to	output	a	text	string	rather	than	a	number.	At	first	sight,	the	following	formula	appears	to	be	working	fine:	=IF(A1="Good",	"1",	"0")	But	the	problem	is	the	returned	1's	and	0's	are	text	values,	not	numbers!	And	if	you	reference	any
cells	with	the	above	formula	in	other	formulas,	those	cells	won't	be	included	in	calculations.	As	soon	as	you	remove	""	surrounding	1	and	0	in	the	above	formula,	Excel	will	treat	the	outputs	as	numbers	and	they	will	be	calculated	correctly.	If	the	small	green	triangles	do	not	appear	in	cells	for	some	other	reason,	look	at	the	Number	Format	box	on	the
Home	tab	in	the	Number	group.	If	it	displays	Text,	try	clearing	all	formatting	for	the	problematic	cells,	and	set	the	cells'	format	to	Number	or	General.	If	that	doesn't	work,	you	might	have	to	create	a	new	column,	manually	input	the	data	(e.g.	copy	your	text-numbers	to	Notepad,	and	then	back	to	a	new	column),	and	delete	the	broken	column.	Another
possible	solution	is	to	multiply	the	values	in	the	problematic	column	by	1	using	a	simple	formula	like	=A1*1.	And	then,	copy	the	formula	cells	and	paste	them	as	values	in	the	same	or	in	any	other	column	via	Paste	Special	>	Values.	Most	of	us	are	used	to	separating	function	arguments	with	commas.	However,	this	does	not	work	for	everyone's	Excel.
The	character	you	use	to	separate	arguments	depends	on	the	List	Separator	set	in	your	Regional	Settings.	Comma	is	the	default	list	separator	in	North	America	and	some	other	countries.	In	European	countries,	comma	is	used	as	the	decimal	symbol	and	the	list	separator	is	usually	set	to	semicolon.	For	example,	in	North	America	you	would	write
=IF(A1>0,	"OK",	"Not	OK"),	while	European	users	of	Excel	should	put	the	same	formula	as	=IF(A1>0;	"OK";	"Not	OK").	So,	if	your	Excel	formulas	are	not	working	because	of	"We	found	a	problem	with	this	formula..."	error,	go	to	your	Regional	Settings	(Control	Panel	>	Region	and	Language	>	Additional	Settings)	and	check	what	character	is	set	as
List	Separator	there.	And	then,	use	exactly	that	character	to	separate	arguments	in	your	Excel	formulas.	When	referring	to	other	worksheets	or	workbooks	that	have	spaces	or	non-alphabetical	characters	in	their	names,	enclose	the	names	in	'single	quotation	marks'.	For	example,	Reference	to	another	sheet:	=SUM('Jan	Sales'!B2:B10)	Reference	to
another	workbook:	=SUM('[2015	Sales.xlsx]Jan	sales'!B2:B10)	For	more	information,	please	see	How	to	refer	to	another	sheet	or	workbook	in	Excel.	If	you	are	writing	a	formula	that	references	a	closed	Excel	workbook,	your	external	reference	must	include	the	workbook	name	and	entire	path	to	the	workbook.	For	example:	=SUM('D:\Reports\
[Sales.xlsx]Jan'!B2:B10)	For	more	information,	please	see	Creating	a	reference	to	another	workbook.	If	the	above	tips	do	not	help,	try	to	evaluate	and	debug	each	part	of	your	formula	individually	by	using	the	F9	key	and	other	debugging	techniques	explained	in	the	following	tutorial:	How	to	evaluate	and	debug	formulas	in	Excel.	Symptoms:	The	value
returned	by	your	Excel	formula	does	not	update	automatically,	i.e.	the	formula	continues	to	show	the	old	value	even	after	you've	changed	the	values	of	the	dependent	cells.	When	Excel	formulas	are	not	updating	automatically,	most	likely	it's	because	the	Calculation	setting	has	been	changed	to	Manual	instead	of	Automatic.	To	fix	this,	just	set	the
Calculation	option	to	Automatic	again.	On	the	Excel	ribbon,	go	to	the	Formulas	tab	>	Calculation	group,	click	the	Calculation	Options	button,	and	select	Automatic:	Alternatively,	you	can	change	this	setting	in	Excel	Options:	In	Excel	2003,	click	Tools	>	Options	>	Calculation	>	Calculation	>	Automatic.	In	Excel	2007,	click	Office	button	>	Excel	options
>	Formulas	>	Workbook	Calculation	>	Automatic.	In	Excel	2010,	Excel	2013,	and	Excel	2016,	go	to	File	>	Options	>	Formulas	>	Calculation	options	section,	and	select	Automatic	under	Workbook	Calculation.	If	for	some	reason,	you	need	to	have	the	Calculation	option	set	to	Manual,	you	can	force	the	formulas	to	recalculate	by	clicking	the	Calculate
button	on	the	ribbon	or	by	using	one	of	the	following	shortcuts:	To	recalculate	the	entire	workbook:	Press	F9,	or	Click	the	Calculate	Now	button	on	the	Formulas	tab	>	Calculation	group.	To	recalculate	an	active	sheet:	Press	Shift	+	F9,	or	Click	Calculate	Sheet	on	the	Formulas	tab	>	Calculation	group.	To	recalculate	all	sheets	in	all	open	workbooks,
press	Ctrl	+	Alt	+	F9.	If	you	need	to	recalculate	only	one	formula	on	a	sheet,	select	the	formula	cell,	enter	the	editing	mode	either	by	pressing	F2	or	double	clicking	the	cell,	and	then	press	the	Enter	key.	Symptoms:	A	cell	displays	the	formula,	not	the	result.	If	your	Excel	formula	is	not	working	because	a	cell	displays	the	function	instead	of	the
calculated	value,	it's	because	one	of	the	following	reasons.	The	most	common	reason	for	an	Excel	formula	not	calculating	is	that	you	have	inadvertently	activated	the	Show	Formulas	mode	in	a	worksheet.	To	get	the	formula	to	display	the	calculated	result,	just	turn	off	the	Show	Formulas	mode	by	doing	one	of	the	following:	Pressing	the	Ctrl	+	`
shortcut,	or	Clicking	the	Show	Formulas	button	on	the	Formulas	tab	>	Formula	Auditing	group.	Another	frequent	reason	for	your	Excel	formula	not	calculating	is	that	the	formula	has	been	formatted	as	text.	To	check	this,	select	the	formula	cell,	and	look	at	the	Number	Format	box	in	the	Number	group	on	the	Home	tab:	If	it	is	the	case,	change	the	cell
format	to	General,	and	while	in	the	cell	press	F2	and	Enter	for	the	formula	to	recalculate	and	display	the	calculated	value.	If	you	have	inadvertently	entered	a	space	or	apostrophe	(')	before	the	equal	sign,	Excel	treats	the	cell	contents	as	text,	and	consequently	does	not	evaluate	any	formula	within	that	cell	(a	leading	space	often	appears	when	you
copy	a	formula	from	the	web).	To	fix	this,	just	remove	the	leading	space	or	single	quote.	This	is	how	you	deal	with	formulas	not	working	in	Excel.	If	you	know	any	other	solutions	to	fix	formulas	not	updating	or	not	calculating,	please	do	share	in	comments.	I	thank	you	for	reading	and	hope	to	see	you	on	our	blog	next	week.


